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1 Important

Safety

Information for Europe:
Know these safety symbols

CAUTION
RISK OF ELECTRIC SHOCK
DO NOT OPEN

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT
REMOVE COVER (OR BACK). NO USER-SERVICEABLE PARTS
INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

A A

The ‘exclamation mark’ calls attention to
features for which you should carefully read the
supplied literature to prevent operating and
maintenance problems.

The 'lightening bolt’ symbol indicates uninsulated
components within the product that can cause
an electric shock.

To reduce the risk of fire or electric shock, do
not expose the product to rain or moisture and
do not place any objects filled with liquids, such
as vases, on the product.

Read these instructions.

Keep these instructions.

Heed all warnings.

Follow all instructions.

Do not use this product near water.

Clean only with dry cloth.

WEO®OEE

Do not block any ventilation openings.
Install in accordance with the
manufacturer’s instructions.

®

o~

EN

Do not remove the casing of this product.

@ Do not expose the product to dripping /
splashing water, rain or high humidity.

Keep this product away from direct
sunlight, naked flames or heat.

@ Do not install near any heat sources
such as radiators, heat registers, stoves,
or other electrical equipment (including
amplifiers).

Do not place any other electrical
equipment on the product.

Do not place any sources of danger
on the product (e.g. objects containing
liquids, burning candles).

® ©® ©

This product may include batteries. Please
refer to safety and disposal instructions
for batteries in this user manual.

©)

Where the mains plug or an appliance
coupler is used as the disconnect device,
the disconnect device shall remain readily
operable.

1N Warning

* Never remove the casing of this apparatus.

* Never lubricate any part of this apparatus.

* Never place this apparatus on other electrical
equipment.

¢ Keep this apparatus away from direct sunlight, naked

flames or heat.

Ensure that you always have easy access to the power

cord, plug or adaptor to disconnect this apparatus from

the power.




1N Warning

* To avoid injuries, never put your fingers into the bass
pipe (1) or your hands into the aluminum ring (2).

Risk of overheating! Never install this apparatus
in a confined space. Always leave a space of

at least four inches around this apparatus for
ventilation. Ensure curtains or other objects
never cover the ventilation slots on this
apparatus.

Mains fuse

This information applies only to products with a
UK mains plug.

This product is fitted with an approved molded
plug. If you replace the fuse, use one with:

*  the ratings shown on the plug,

e aBS 1362 approval, and

*  the ASTA approval mark.

Contact your dealer if you are not sure about
what type of fuse to use.

Caution: To conform with the EMC directive
(2004/108/EC), do not detach the plug from
the power cord.

Notice

q

This product complies with the radio
interference requirements of the European
Community.

C€ 0560 (1) RaTTE Directive 1999I5/EC

BG VRO V [Be VIIT /[ /]IS V/]sE /|
K VIES V|cz /INL VAT V[V /][sK V|
FR VUK V[ /IPT /ey /IMT /IPL /
HU V/INO V/IGR /sl V[EE V/
T VI VIE VIcH V/IDE vV

The device can be operated in the EU without
restrictions indoor, but cannot be operated
outdoors in France in the whole of the band
until further notice

This product complies with the requirement of
the 1999/5/EC directive.

Modifications

Modifications not authorized by the
manufacturer may void user's authority to
operate this product.

s

Your product is designed and manufactured
with high quality materials and components,
which can be recycled and reused.

)i

When this crossed-out wheeled bin symbol is
attached to a product it means that the product
is covered by the European Directive 2002/96/
EC.

Please inform yourself about the local separate
collection system for electrical and electronic
products.

Please act according to your local rules and

do not dispose of your old products with your
normal household waste. Correct disposal of
your old product helps to prevent potential
negative consequences for the environment and
human heatth.

)¢

Your product contains batteries covered by
the European Directive 2006/66/EC, which
cannot be disposed with normal household
waste.Please inform yourself about the local
rules on separate collection of batteries
because correct disposal helps to prevent
negative consequences for the environmental
and human heatth.
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Information about the use of batteries:

“ Caution

¢ Risk of leakage: Only use the specified type of batteries.
Do not mix new and used batteries. Do not mix
different brands of batteries. Observe correct polarity.
Remove batteries from products that are not in use for
a longer period of time. Store batteries in a dry place.

¢ Risk of injury: Wear gloves when handling leaking
batteries. Keep batteries out of reach of children and
pets.

* Risk of explosion: Do not short circuit batteries. Do
not expose batteries to excessive heat. Do not throw
batteries into the fire. Do not damage or disassemble
batteries. Do not recharge non-rechargeable batteries.

Environmental information

All unnecessary packaging has been omitted.
We have tried to make the packaging easy to
separate into three materials: cardboard (box),
polystyrene foam (buffer) and polyethylene
(bags, protective foam sheet.)

Your system consists of materials which can
be recycled and reused if disassembled by

a specialized company. Please observe the
local regulations regarding the disposal of
packaging materials, exhausted batteries and old
equipment.

-
Made for

\ BiPod [JiPhone [JiPad
[al

AirPlay

“Made for iPod,”“Made for iPhone,” and “Made
for iPad” mean that an electronic accessory
has been designed to connect specifically to
iPod, iPhone, or iPad, respectively, and has

been certified by the developer to meet
Apple performance standards. Apple is not
responsible for the operation of this device

or its compliance with safety and regulatory

standards. Please note that the use of this
accessory with iPod, iPhone, or iPad may affect
wireless performance.

AirPlay, iPod, and iPhone are trademarks of
Apple Inc, registered in the US. and other
countries. iPad is a trademark of Apple Inc.

Class Il equipment symbol:

=

CLASS Il apparatus with double insulation, and
no protective earth provided.

* The type plate is located on the bottom of the
apparatus.




2 Your
Entertainment
System

Congratulations on your purchase, and
welcome to Philips! To fully benefit from the
support that Philips offers, register your product
at www.philips.com/welcome.

If you contact Philips, you will be asked for the
model and serial number of this apparatus. The
model number and serial number are on the
bottom of the apparatus. Write the numbers
here:

Model No.

Serial No.

Introduction

Apple AirPlay technology enables you to play
your iTunes music library, hosted on a Mac, PC,
iPhone, iPod touch, or iPad on any AirPlay-
enabled device (for example, your DS3800WV)
connected to the Wi-Fi network.
With an AirPlay-enabled device (for example,
your DS3800W), you can:
*  stream audio from your iTunes music
library to any room in your house
*  choose which AirPlay-enabled devices
you want to play music on (if you
have more than one such devices in
your house)
*  stream audio to multiple AirPlay-
enabled devices at the same time
(from the iTunes music library on your
PC/Mac only)

-

* Please visit www.philips.com/welcome for information
about more Philips AirPlay-enabled devices.

With DS3800VV, you can also:

charge your iPod/iPhone/iPad through
the USB socket with an Apple USB
cable (not supplied).

play your iTunes music library on your
iPod/iPhone/iPad through the USB
socket directly while charging.

play music from other audio devices
through the MP3-LINK socket.

What’s in the box

Check and identify the contents of your package:

Main unit (with a built-in Wi-Fi module)
1 x AC power adapter

1 x MP3 link cable

User manual (in CD-ROM)

Quick start guide

What else you need

To stream audio wirelessly by AirPlay, you need:

A Wi-Fi certified router
A host for your iTunes music library,
for example, an iPod touch/iPhone/
iPad installed with iOS 4.3 (or later)
or a Wi-Fi enabled PC/Mac installed
with iTunes 10 (or later)

Your DS3800W should be connected to the
same local network as your iTunes host device
through the Wi-Fi router.

List of compatible iTunes host devices

for AirPlay

In terms of AirPlay, DS3800WV is compatible with:

*  aWi-Fi enabled PC/Mac installed with
iTunes 10 (or later); and

»  the following iPod/iPhone/iPad models
installed with iOS 4.3 (or later):

iPad 2

iPad

iPhone 4

iPhone 3GS

iPod touch (2nd, 3rd, and 4th
generation)
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Overview of the main unit

®

@ Power indicator

@ o

e Turn the unit on/off.

3 »n

*  Start or pause play.

@ +-
*  Adjust volume.
*  (Press and hold both buttons) reset
the unit.

(5 DCIN

»  Connect the power adaptor.

(&) WI-FI SETUP button/indicator
*  Connect the unit to a Wi-Fi network.
*  Show the Wi-Fi connection status of
the unit.

(7) MP3-LINK
»  Connect an external audio player
through the supplied MP3 link cable.

USB <

*  Connect an iPod/iPhone/iPad through
an Apple USB cable (not supplied).



Get started to use AirPlay

To get started with AirPlay, you need to:

1 Upgrade your iPod touch/iPhone/iPad to
the latest iOS version (iOS 4.3 or later).

*  Orinstall the latest version of iTunes
(iTunes 10 or later) on your PC/Mac.

2 Connect power to DS3800WV, then turn it
on (see ‘Prepare’ on page 10).

3 Connect DS3800W to your existing home
Wi-Fi network (see ‘Connect to your home
Wi-Fi network for AirPlay’ on page 11).

4 Make sure that your iPod touch/iPhone/
iPad or PC/Mac are also connected to the
same Wi-Fi network.
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3 Prepare

Always follow the instructions in this chapter in
sequence.

Connect power

n Caution

Risk of product damage! Make sure that the power
supply voltage matches the voltage printed on the
bottom of the unit.

Risk of electric shock! When you unplug the AC
adaptor, always pull the plug from the socket. Never
pull the cord.

Before you connect the AC adaptor, make sure that you
have completed all the other connections.

10

Connect the AC power cord to

*  the DCIN socket on the back of the
unit.

*  the wall power socket.

Turn DS3800VV on

Press O on the top to turn the unit on.
Wait for successful boot-up of the unit.
% The boot-up takes about 35 seconds.

> During boot-up, the Wi-Fi SETUP
indicator on the back of the unit blinks
green quickly.

L After boot-up, if no Wi-Fi connection
has been set up for DS3800VV, the
Wi-Fi SETUP indicator starts to blink
green slowly.

To turn the unit off, press O again.



Before connection of DS3800W to you home

4 C onn eCt to Wi-Fi network, check the points below.
)’O ur h ome W| - 1 Make sure that your Wi-Fi router is

powered on and working properly.

FI netwo |"|( for' 2 Make sure that DS3800W has been

powered on and booted up successfully

Ai rPIay (see “Turn DS3800W on’ on page 10).

3 Identify the type of your Wi-Fi router (see
the user manual of your Wi-Fi router for
details).

Scenario 1: Connect to a
WPS router

¢ Before you press any button on DS3800W, make sure
that DS3800WV has been booted up successfully (see
Turn DS3800W on'’ on page 10).

1 Press the WPS button on your home Wi-Fi
router.

To connect DS3800WV to your existing home
Wi-Fi network, you need to apply your home
Wi-Fi settings to DS3800WV.

You can do this in two ways (depending on
which type of Wi-Fi router you use):

e Automatically - if your Wi-Fi router is
WPS (Wi-Fi Protected Setup)-enabled
and supports PBC (Push Button
Connection) (see ‘Scenario 1: Connect
to a WPS router' on page 11)

e Manually - if your Wi-Fi router does
not support WPS (see ‘Scenario 2:
Connect to a non-WPS router’ on
page 12)

Once connected successfully, DS3800W will
remember your home Wi-Fi settings. Then

you can enjoy AirPlay whenever DS3800WV is
powered on and connected to your home Wi-
Fi network automatically.
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2 Shortly after step 1, press Wi-Fi SETUP on
the back of DS3800WV.
L The Wi-Fi SETUP indicator blinks red,
yellow and green alternately.
> Within 2 minutes, the WI-FI SETUP
indicator stops blinking and stays green,
and the unit beeps.

& DS3800W is connected to your home
Wi-Fi network successfully.

* For some Wi-Fi routers, you may need to hold the
WPS button for Wi-Fi connection or enable the WPS
PBC function from the router configuration pages. See
the user manuals of the specific routers for details.

¢ If the Wi-Fi SETUP indicator on DS3800WV blinks
yellow, it means that the Wi-Fi connection has failed.
Please wait for 2 minutes and try again. If the problem
remains, try to set up the Wi-Fi connection manually
(see ‘Scenario 2: Connect to a non-WPS router' on
page 12).

* If the Wi-Fi connection fails again, press and hold both
the + and - buttons on the top of DS3800W to reset
it,and then try again.

12 EN

Scenario 2: Connect to a
non-WPS router

Note

* You can also follow the procedures below to connect
DS3800W to a WPS router manually.

To connect DS3800WV to a Wi-Fi router
manually, you need access to DS3800W's
built-in configuration web page for change of
its internal Wi-Fi settings. To do so, you need a
Wi-Fi enabled device with an Internet browser
for temporary Wi-Fi connection to DS3800WV.
The Wi-Fi enabled device can be an iPod touch/
iPhone/iPad or a Wi-Fi enabled PC/Mac.

Follow the sequence below for connection of
DS3800W to a non-WPS Wi-Fi router.

1 Collect settings of your home Wi-Fi router
and write down on paper for use during
DS3800W Wi-Fi setup (see ‘Collect
settings of your home Wi-Fi router’ on
page 13).

2 Switch DS3800W to Assisted Wi-Fi Setup
mode (see ‘Switch DS3800WV to Assisted
Wi-Fi Setup mode’ on page 13).
> A new Wi-Fi network created by

DS3800W will appear, with the
network name (SSID) of Philips Fidelio
AirPlay.

3 Connect your Wi-Fi enabled device to the
created new Wi-Fi network temporarily
(see ‘Connect your Wi-Fi enabled device to
the newly created Wi-Fi network' on page
14).

4 Open the built-in web page of DS3800W
with the Internet Browser of your Wi-Fi
enabled device (see ‘Open the built-in web
page of DS3800W' on page 15).

5 Change the internal Wi-Fi settings of
DS3800WV based on the settings you
wrote on paper at step 1 (see ‘Change the
internal Wi-Fi settings of DS3800W' on
page 16).



6 Restore your Wi-Fi enabled device back
to your existing home Wi-Fi settings (see
‘Restore your Wi-Fi enabled device back to
your existing home Wi-Fi setting’ on page 17).

Collect settings of your home Wi-Fi
router

* Always consult the user manual of your home Wi-Fi
router for detailed instructions.

1 Connect your Wi-Fi enabled device to
ba
your existing home Wi-Fi network.

2 Launch the Internet browser (for example,

Apple Safari or Microsoft Internet *  Press and hold Wi-Fi SETUP on the back

Explorer) on your Wi-Fi enabled device. of DS3800W for more than 5 seconds.

) % The Wi-Fi SETUP indicator blinks

3 Open the configuration page of your green and yellow alternately

home Wi-Fi router. '
4 Find the WiFi settines tab and write d A new Wi-Fi network created by

nd the YVI-T SETngs 1ab and wrtte down DS3800W will appear; with the network

tgﬂ,’\'l'ow'”gl!”forma“sosrl‘;” paper: name (SSID) of Philips Fidelio AirPlay.
t
etwork name ( ) > [t may take up to 45 seconds for

y\/i;i Ziw\/\/rg;;nifo'zsa(t?l:gly WER successful creation of this new Wi-Fi

network.
© Wi-Fi password (if Wi-Fi security is
enabled)
(D) DHCP mode (enabled or disabled) E Note
@ Static IP address settings (If DHCP * After you finish manual Wi-Fi setup for DS3800WV,
mode is disabled) the new Wi-Fi network created by DS3800W will
disappear.
* If you fail to enter Assisted Wi-Fi Setup mode, power
Switch DS3800VV to Assisted Wi-Fi off DS3800W and power on it, then try again after
successful boot-up.
Setup mode * Make sure that there are no other Philips AirPlay-
enabled devices in Assisted Wi-Fi Setup mode at the
Note same time. Multiple Wi-Fi networks created this way
may interfere with each other.

* Before you press any button on DS3800W, make sure
that DS3800WV has been booted up successfully (see
Turn DS3800W on'’ on page 10).
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Connect your Wi-Fi enabled device to
the newly created Wi-Fi network

The new Wi-Fi network created by DS3800W
only allows access of one Wi-Fi enabled device.To
avoid interference from any other Wi-Fi devices,
you are recommended to temporarily disable the
Wi-Fi function on your other Wi-Fi devices.

Option 1: Use your iPod touch/iPhone/iPad

1 select Settings -> Wi-Fi on your iPod
touch/iPhone/iPad.

Settings

(&) Notifications

Carrier

ki Brightness

ﬁ Wallpaper

v General >

2 Select Philips Fidelio AirPlay from the list
of available networks.

14 EN

setings ~ Wi-Fi Networks

Philips Fidelio AirPlay

JPhillqud/elio_Mr... (> )

>

3 Wait until successful Wi-Fi connection on
your iPod touch/iPhone/iPad.
> = is displayed at the upper left corner
of your iPod touch/iPhone/iPad.

Tip

* If Philips Fidelio AirPlay is not in the list, try to scan the
available Wi-Fi networks again.

Use your Wi-Fi enabled PC/Mac

Note

* See the user manual of your PC/Mac for how to
connect your PC/Mac to a Wi-Fi network.

¢ During Wi-Fi network connection, do not connect any
network cable to your PC/Mac.

1 Open the Wi-Fi setup tool or control
panel on your PC/Mac.



2 Scan the available Wi-Fi networks.

3 Select Philips Fidelio AirPlay from the list
of available networks.

rhamalon.
J a—— - Comnected 7 &
o Ty Lo e ur) # 3

1 Seurty sratied e sk will |
Relsted Ty . i
i s st i ‘.J
Fatmring [rr—p——— |
i hange the order of
i B

-
¥ Targe atvnced
T

{“‘,, s —

U acurty-srablad mrelbss otk (WDRZ) aill
g = 3

4 Wait until successful Wi-Fi connection on
your PC/Mac.

(er} -

4o Chinge bt { securty-snatied mreless netmort.
o “i” -

e

(TI .

¢ Bonurky-enabied wesless reta.

L=

B EE.

I

Tip

* If Philips Fidelio AirPlay is not in the list, try to scan the

available Wi-Fi networks again.

Open the built-in web page of
DS3800W

1 Launch Apple Safari browser or any other
Internet browser on your Wi-Fi enabled
device.

2 Typein 192.168.1.1 at the browser
address bar and confirm.

% The DS3800VV configuration web

page is displayed.

lext box. Click App
device name change.
Philips Fidelio device name: Philios_Fidefio 2398FA

Please select your wireless network and enter
your network password if applicable. For
advanced network setup, please click
Advanced, Click Apply to connect your wireless
speaker to your network.

Please select your Wi-Fi network: option. [§

< s ©

EN
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If you use Safari on your Wi-Fi enabled PC/
Mac, you can also select ‘Philips_Fidelio XXX’
from the Bonjour pull-down list to enter the
DS3800WV configuration web page directly.

1 Click % > Preferences.
> The Bookmarks menu is displayed.

Pl P— ]

e :-—-J wpano o pr
Custamize Toolbar

Frilips Fidelio

Hide Menu Bar

Hide Bookmarks Bar ~ ChrlShift+8
Hide Tab Biar Ctrl+shift+T

Hide Status Bar Ciri+f

History Ctri+H |
Dowrloads Chri+alt+.

Private Erowsing.
Reset Safari
Block Pop-lp Windows  CrrbShift+

——
e
Help F1
Report Bugs to Apple.

Safari Extensions Gallery
About Safari

2 Tick Include Bonjour for Bookmarks bar.

3 Select 'Philips_Fidelio XXX’ from the
Bonjour pull-down list shown at the
bookmarks bar.

% The DS3800W configuration web
page is displayed.

Bonjour ¥ | Apple  ¥ahoo!  Go bt At

Abaout Bonjour

Philips_Fideli

Change the internal Wi-Fi settings of
DS3800W

On the DS3800WV configuration web page,
you can change the internal Wi-Fi settings of
DS3800WV for connection of DS3800W to
your existing home Wi-Fi network.

Note

* Make sure that the settings on the configuration web
page match your home Wi-Fi network settings that you
wrote on paper.

192.168.1.1 [

Py Fidelo ‘
Welcome o Philips Fidelio setup page. Follow the
#lapa balow 1o connect your wirsless spaaker lo your
wirchess network

You can keep the default device name ar
modily the device name by modifying the taxt

i the bext box. Clck Apoly o procesd with
Phiipe Fidalio devics nama; Freden Fiiwis 110854
ooy

Plaase selact your wirelass natwark and enter
your network password |f applicable. For
advanced network selup, please ciick
Advanced, Click Apply to connect your wineless
spaaker o your network,

Pinass selact your Wi-Fl notwork: (S ouen I

4 = m O

*  Follow the on-screen instructions to
change and confirm the internal Wi-Fi
settings of DS3800WV.

L After a while, the indicator on the back
of DS3800WV stops blinking and stays
green, and the unit beeps.

> DS3800W is connected to your
existing home Wi-Fi network
successfully.



B

* If the WI-FI SETUP indicator on DS3800W does not
stay green steadily, it means that the Wi-Fi connection
has failed. Please power off both your Wi-Fi router
and DS3800W and then power on them again to see
whether DS3800W can be connected to your home
Wi-Fi network. If the problem remains, try the above
procedures again.

* After you finish the above changes or power-off and
power-on of DS3800W, the new Wi-Fi network
created by DS3800W will disappear:

o

* If you like, you can change the name of your DS3800W
in Advanced settings -> AirPlay Device Name on the
DS3800W configuration web page. This is helpful when
you have multiple Philips AirPlay-enabled devices in
your house and you need to distinguish between them.

* If you want to enter the network name (SSID) manually
(for example, if you want to hide your SSID), go to
Advanced settings -> CONFIGURE MANUALLY on
the DS3800WV configuration web page.

Restore your Wi-Fi enabled device
back to your existing home Wi-Fi
setting

Note

* Make sure that the settings at steps 2 to 3 below match
your home Wi-Fi network settings you wrote on paper.

1 Select Settings -> Wi-Fi on your iPod
touch/iPhone/iPad.
*  Oropen the list of available Wi-Fi
networks on your PC/Mac.

Settings

= I QUEE

E Notifications

. Carrier

m MNanaral S

2 Select your network name (SSID) from the
list of available wireless networks.

sertings  Wi-Fi Networks

Ask to Join Networks [Wel/l

3 Enter the network key if required.

4 Wait until successful Wi-Fi connection to
your home Wi-Fi network.
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5 Play

Stream audio from your
iTunes music library to
DS3800W

Note

* Make sure that your iTunes host device is connected
to the same Wi-Fi network as DS3800W.Your iTunes
device can be an iPod touch/iPhone/iPad installed with
iOS 4.3 (or later) or a Wi-Fi enabled PC/Mac installed
with iTunes 10 (or later).

Stream from your iPod touch/iPhone/
iPad

1 Launch the iPod application on your iPod
touch/iPhone/iPad.

2 Tap on the AirPlay icon.

@ * Symphony No. 8 (Sche

3 Select Philips_Fidelio XXXX (or user
customized name) from the AirPlay list.

4 Select a media file and start play.
> After a while, you will hear music from
DS3800WV.

¢ |1 Wl

A———

¢ If you fail to hear music after successful setup, do one of
the following on your iPod touch/iPhone/iPad:

¢ (1) Disconnect and then re-connect to the same Wi-Fi
router again;

* (2) Close all applications running at the background,

* (3) Power off and then power on your iPod touch/
iPhone/iPad again.




Stream from your PC/Mac

1 Launch iTunes 10 (or a later version) on
your PC/Mac.

2 Click the AirPlay icon on the window.

Tip

* When you stream audio from your iTunes music library
on a PC/Mac, you can select more than one AirPlay-
enabled devices (if available) at step 3 to stream music
to all of them at the same time.

¢ If you are using an earlier version of iTunes, the AirPlay
icon may be £ instead of [al.

i

3 Select Philips_Fidelio_AirPlay XXXX (or
user customized name) from the AirPlay
list.

4 Select a media file and start play.
> After a while, you will hear music from
DS3800WV.

[

Control play

You can select different play options from either
your iTunes host device or DS3800WV.

Note

* Make sure that you have successfully streamed audio
from your iTunes music library to DS3800W.

* o pause or resume play, press » .
* o adjust volume, press +/- repeatedly.

Tip

* If you are streaming music from a PC/Mac, to control
music play from DS3800WV, remember to tick Allow
iTunes audio control from remote speakers in Edit ->
Preferences -> Devices on iTunes.

Use advanced sound settings

If your iTunes host device is an iPod touch/
iPhone/iPad:

For advanced sound settings and additional
features, you can use your iPod touch/iPhone/
iPad to download the Philips Fidelio application
from Apple App Store. It is a free application
from Philips.
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If your iTunes host device is a Wi-Fi enabled
PC/Mac:

For advanced sound settings, you can use the
equalizer available on iTunes directly (View ->
Show Equalizer).

5 I

¢ See the iTunes help documentation for more details.

Play/charge your iPod/iPhone/

iPad through USB socket

Note

* The USB socket is only compatible with iPod/iPhone/
iPad.

You can play or charge your iPod/iPhone/iPad
through the USB socket with an Apple USB
cable (not supplied).

If you have stopped audio streaming by AirPlay,
after successful USB connection, the unit
switches to the USB source automatically.

20 EN

*  Connect an Apple USB cable (not

supplied) to:

»  the USB <5 socket on the back of
DS3800WV.

*  the dock connector on your iPod/
iPhone/iPad.

Compatible iPod/iPhone/iPad

The USB socket supports play and charge of
the following iPod, iPhone, and iPad models.
e iPad2

* iPad

* iPhone 4

*  iPhone 3GS

e iPhone 3G

* iPhone

* iPod classic

* iPod 5G

* iPod 4G

* iPod nano (2nd, 3rd, 4th, 5th, and 6th
generation)

*  iPod touch (1st, 2nd, 3rd, and 4th
generation)

Play from an external device

You can also listen to an external audio player
through the unit.

If you have stopped both audio streaming by
AirPlay and direct music play through the USB
socket, DS3800WV switches to the MP3 link
source automatically.



Connect the supplied MP3 link cable to:

»  the MP3-LINK socket on the back of
the unit.

*  the headphone jack on an external
audio player.

EN
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6 Update
firmware

To improve the performance of DS3800V,
Philips may offer you new firmware for upgrade
of your DS3800WV.

Please register your product at
www.philips.com/welcome for information
about the latest firmware.

Note

* You can only update the firmware from a PC/Mac.

Download the update file

ool—= i
a e _ R )
PH olwww.philips.com/support| I eI I
e e T s |_
e | 88 united Kingdom / English
Register your product / Login | XXXX ()
T - 8
- oz

|_
©| & o0xzp

1 on your PC/Mac, go to
www.philips.com/support.

2 Enter the model number to find the latest
firmware upgrade file available.

3 Saethe upgrade file to your hard drive.
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Update from the
configuration page

'!‘ Warning

* Always connect your DS3800W to AC power for
firmware upgrade. Never power off your DS3800W
during firmware upgrade.

Note

* To use an Internet browser other than Apple Safari
on your PC/Mac, remember to go to the Wi-Fi router
configuration page and write down the IP address of
your DS3800WV. See the user manual of your Wi-Fi
router for how to find the IP addresses of devices
connected to the Wi-Fi router.

1 Power on DS3800W (see ‘Prepare’ on
page 10).
> |t takes about 35 seconds for the unit
to boot up. During boot-up, the WI-FI
SETUP indicator on the back of the
unit blinks green quickly.

> After boot-up, you can hear a beep
and the WI-FI SETUP indicator
turns to green steadily. DS3800WV is
connected to the last configured Wi-Fi
network automatically.

2 Make sure that DS3800W and your
PC/Mac are connected to the same Wi-Fi
router.

3 Open Apple Safari on your PC/Mac, then
select ‘Philips_Fidelio XXX’ from the
Bonjour pull-down list.

*  Or open any other Internet browser
on your PC/Mac, then type in the IP
address of DS3800WV (available on
the Wi-Fi router configuration page)
at the address bar.

5 The DS3800W configuration
web page is displayed.
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Follow the on-screen instructions to
complete the firmware update.

In case the firmware update fails, you can try the above
procedures again.

After successful firmware update, if there is any
problem with the Wi-Fi connection, press and hold
both the + and - buttons on DS3800WV for more than
5 seconds at the same time to reset the device, and
then try to set up the Wi-Fi network for DS3800W
again (see ‘Connect to your home Wi-Fi network for
AirPlay’ on page 11).
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/ Product
information

Note

General information

AC power

Input: 100 - 240V~,
50/60 Hz 1A/M1.2 A
Output: 12V =30A

Operation Power
Consumption

30W

¢ Product information is subject to change without prior

notice.

Power Consumption in

Standby Mode

<05W

Dimensions
- Main Unit (L xW
x H)

198 x 100 x 196 mm

Specifications

Amplifier

Weight
- With Packing
- Main Unit

171 kg
1.05 kg

Rated Output Power

4 X 4W RMS

Frequency Response

63 - 20 kHz

Signal to Noise Ratio

>75dB

MP3 Link

650 mV RMS 20 kohm

Speakers

Speaker Impedance 8 ohm

Speaker Driver 40 mm full range
Sensitivity 78 dB/m/W
Wireless

Wireless 802.11b/g

standard

Wireless WEP (64 or 128 bit),
security WPA/WPA?2 (8-63 characters)
Frequency 2412 - 2462 MHz (CH1-
range CH11) (for /79,/37,1/55,197)

2412 - 2472 MHz (CH1-
CH13) (for /12, /10, /05)

PBC (one Yes
button push)
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8 Troubleshooting

'!‘ Warning

* Never remove the casing of this apparatus.

To keep the warranty valid, never try to repair
the system yourself.

If you encounter problems when using this
apparatus, check the following points before
requesting service. If the problem remains
unsolved, go to the Philips web site
(www.philips.com/welcome).When you contact
Philips, ensure that the apparatus is nearby

and the model number and serial number are
available.

No power

*  Make sure that the AC power plug of the
device is connected properly.

*  Make sure that there is power at the AC
outlet.

No sound

*  Adjust the volume.

*  Check the Wi-Fi network connection.
Set up the network again if needed (see
‘Connect to your home Wi-Fi network for
AirPlay’ on page 11).

No response from the unit

*  Press and hold both the + and - buttons
on DS3800WV for more than 5 seconds
to reset the device. Then set up the
Wi-Fi network for DS3800WV again (see
‘Connect to your home Wi-Fi network for
AirPlay’ on page 11).

*  Disconnect and reconnect the AC power
plug, and then switch on the device again.

Wi-Fi network connection failed

e Check if your Wi-Fi router is Wi-Fi
802.11b/g certified. This device is only
compatible with Wi-Fi 802.11b/g certified
routers.

If your Wi-Fi router is Wi-Fi 802.11n
certified, make sure to enable the
802.11b/g mode. DS3800WV does not
support connection to routers with
802.11n only.

*  This device does not support the WPS-
PIN method.

*  If your Wi-Fi router supports WPS and
the WPS-PBC method but fails to connect
to DS3800WV, try the manual Wi-Fi setup
method (see ‘Scenario 2: Connect to a
non-WPS router’ on page 12).

*  Enable SSID broadcast on the Wi-Fi router.

*  Keep away from potential sources of
interference which may affect Wi-Fi signal,
such as microwave ovens.

*  If you fail to use your PC for Wi-Fi network
setup, check whether your PC is using a
Wi-Fi network.You cannot use Ethernet
connection for AirPlay network setup.

*  Make sure that the SSID name of your
home router consists of alphanumeric
characters, with no space or special
characters like %/#/* inserted.

*  If you choose to rename the AirPlay device
‘Philips_Fidelio XXXX'in the setting
menu, do not use special characters or
symbols.

*  Forsome new types of Wi-Fi routers, a
network name (SSID) may be created
automatically when you use WPS for
connection. Always change the default
network name (SSID) to a simple one that
consists of alphanumerical characters, and
also change the Wi-Fi security mode to
secure your network.

Occasional breaking of AirPlay music

streaming

Do one or all of the following:

*  Move DS3800W closer to your Wi-Fi
router.

*  Remove any obstacles between DS3800W
and your Wi-Fi router.

*  Avoid using Wi-Fi channel which is
overlapped by the nearby Wi-Fi network.
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Check if your network speed is fast enough
(in cases where multiple devices share the
same router, the AirPlay performance may
be affected). Turn off the other devices
connected to your home router.

Enable the Quality of Service (QoS)

option (if available on the Wi-Fi router).
Turn off other Wi-Fi routers.

No AirPlay icon on my iTunes host device

Make sure that DS3800WV is already
connected to your home Wi-Fi network.
Before you open iTunes, make sure that
you have enabled Bonjour service in
your PC.Take Windows XP for example:
to enable the service, you can click
Start->Control Panel, and double-click
Administrative Tools-> Services->Bonjour
Service, then click Start followed by OK
on the pop-up menu.

If the problem remains, try to restart
DS3800WV.

AirPlay connection failed with Mac or PC

26

Temporarily disable the firewall and
security software to see whether it blocks
the ports that AirPlay uses to stream
content. See the help documentation of
your firewall and security software on how
to unblock the ports used by AirPlay.
When you use iPod Touch/iPhone/iPad/
Mac/PC for AirPlay, if the music play breaks
or stops, try to restart your iPod Touch/
iPhone/iPad, iTunes or DS3800WV.

Video streaming or FTP downloads may
overload your router and therefore may
cause interruptions during AirPlay music
play. Try to reduce the load of your router.
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